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Wix je jedna od najpopularnijih 
platformi za dizajn web prezent-
acija, koja omogućava izradu i 
održavanje web-sajtova bez 
angažovanja programera. Do sada 
(septembar 2020), na ovoj 
platformi je napravljeno preko 110 
miliona sajtova, uz 45.000 novih 
registracija svakog dana. 

Kreiranje web stranice sa Wix-om 
može se realizovati na dva načina - 
preko Wix ADI (lakše, ali sa manje 
opcija, koristi elemente vještačke 
inteligencije (otuda naziv Arti�cial 
Design Intelligence)) i Wix Editora 
(malo teže, uz više �eksibilnosti u 
dizajnu).

Wix Editor je standardni kreator 
web stranica, na kojem možete 
izabrati jedan od preko 500 
templejta, kategorisanih u 16 
oblasti. Kada se odabere templejt 
koji najbolje odgovara potrebama 
posla (bilo da se radi o malim 
�rmama, restoranima, internet 

TEME SEMINARA:

WIX.COM
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prodavnicama, blogovima, sajtovi-
ma profesionalnih fotografa ili bilo 
šta drugo), možete da prevučete i 
ispustite (drag&drop) različite 
gra�čke i tekstualne elemente, da 
biste izgled sajta još bolje prila-
godili. To se realizuje preko Wix 
Meni editora koji daje mnogo 

opcija za podešavanje pojedi-
načnih elemenata sajta. Takođe, u 
okviru Wix Editora, korisnici imaju 
pristup i Wix-ovom tržištu aplikaci-
ja gdje je moguće, uz komercijalne 
planove, koristiti i mnogo Wix 
dodataka/aplikacija, ali i drugih od 
nezavisnih proizvođača. 
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Meni u Wix Editor-u je jednostavan 
za korišćenje i pruža mnogo opcija 
za prilagođavanje web-strane (u 
standardnim ili u rezolucijama za 
mobilne telefone).

Menus & Pages daje mogućnost 
editovanja svake pojedinačne 
strane web sajta. Izborom 
+AddPage opcije, dodaje se nova 
stranica koju je potrebno imeno-
vati. Nakon dodavanja, svaku od 
stranica moguće je promijeniti i 
podesiti izborom ikonice u obliku 
"…" u desnom kraju stavke menija, 
gdje su na raspolaganju opcije 
Rename za preimenovanje, Copy 
za kopiranje, Duplicate za dupli-
ranje konkretne stranice, Hide/-
Show za uklanjanje ili prikazivanje 
stranice u meniju, Subpage ako 
želite da stranica bude podstrani-
ca neke od postojećih i delete za 
brisanje. Takođe, tu su i opcije 
Settings za detaljno podešavanje 
stranice, i izdvojene opciije SEO i 
Social Shere, koje isto tako 
možete pronaći u Settings.

Osim standardnih podešavanja 
imena i prikazivanja stranice, 
najvažnije je dobro podesiti detal-
je SEO optimizacije, jer to de�niše 
koliko lako i brzo korisnici pronala-
ze tu stranicu ili cijeli sajt na Goog-

le-u. To uključuje tkz. slag (eng. 
slug) stranice, odnosno putanju, 
zatim naslov i opis stranice. 
Prilikom de�nisanja naslova bi se 
trebalo ograničiti na oko 60 
slovnih karaktera, dok je za opis 
preporučljivo da bude do 160, iako 
je i do 300 sasvim u redu. Kada 
de�nišete opis stranice, potrebno 
je da sadrži informacije koje će 
privući posjetioce koji vrše 
pretragu. Tako treba izbjegavati 
opise koji nemaju veze sa sadrža-
jem stranice, ne treba koristiti 
generičke opise kao "Ovo je web 
stranica" ili "Stranica o nama/me-
ni", kao ni upotrebu istog opisa na 
svim stranicama ili grupi stranica 
na sajtu.

Stavka Background omogućava 
postavljanje pozadinske slike, boje 
ili videa u određeni segment ili 
preko cijele stranice. Wix nudi 
nekoliko desetina gotovih foto-
gra�ja koje je moguće upotrijebiti 
u ovu svrhu, a klikom na dugme 
Image -> Upload Media, moguće je 
izabrati i fotogra�ju sa lokalnog 
diska. Ista procedura se primjenju-
je kod izbora video fajla.

Opcija Add je najkompleksnija u 
Wix meniju i omogućava dodavan-
je najrazličitijih elemenata na 
web-stranicu, počevši od tekstu-
alnih segmenata, slika, akcionih 

dugmadi, galerija, preko listi, 
formi, opcija za elektronsku 
prodavnicu i mnogo čega još.

Još jedna interesantna opcija 
menija je Start Bloging, koja omo-
gućava kreiranje i postavljanje 
blogova na web-sajt. I ovdje 
postoje dodatne opcije za podeša-
vanje koje omogućavaju da se 
podesi slika na stranici (cover 
image), zatim da se zakaže datum 
objave, da se postavi 140 slovnih 
karaktera duga poruka koja treba 
da motiviše čitaoce da ostanu da 
čitaju, kao i nekoliko dodatnih 
opcija, uključijući i onu da li je 
komentarisanje dozvoljeno. 
Takođe, ovdje su opcije za SEO 
optimizaciju, za strukturiranje 
blogova u kategorije, dodavanje 
tagova i de�nisanje planova za 
pretplatu ako namjeravate da svoj 
blog učinite komercijalno dostup-
nim.
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Pored Wix Menija, u Wix Editoru 
dostupni su Wix Chat i Editor Tool-
bar. I dok Editor Toolbar služi za 
�no podešavanje boja, fontova, 
veličine i stila teksta, kao i raznih 
efekata i SEO optimizacije svakog 
tekstualnog elementa, izborom 
opcije Settings u okviru Wix 
Chat-a, možete podesiti chat za 
komunikaciju sa klijentima i 
javnošću. Ovdje postoje različite 
stavke izbora izgleda, pozadine i 
načina funkcionisanja chat komu-
nikacije, a ako se tako podesi svaka 
poruka upućena od strane klijenta 

Kontrolna tabla (Dashboard) je prva stranica koju 
vidite nakon prijavljivanja na JIRA-u. navigacija (na 
vrhu ekrana) je ista na svim ekranima, i sadrži veze 
koje omogućavaju brzi pristup najkorisnijim funk-
cijama JIRA okruženja. Bijelo područje na ekranu, 
ispod navigacije može da se prilagodi tako da 
prikazuje najvažnije pokazatelje ili projekte kojima 
se često pristupa.

Svaki projekat ima ime i ključ. Ključ projekta kasnije 
postaje prvi dio ključa svih kreiranih zadataka u 
okviru toga projekta. Novi projekat se kreira klikom 
na Projects ->Create project u okviru navigacije. U 
formi koja slijedi, dovoljno je unijeti ime projekta i 
izabrati templejt, kojih ima u kategoriji Software i 
Business. Izbor templejta de�niše inicijalni radni 
tok zadataka u projektu, mada je taj tok svakako 
moguće manuelno promijeniti dodavanjem statu-
sa i tranzicija po potrebi (Project Settings ->Work-
�ows ->Edit na podrazumijevani dijagram).

Atlassian JIRA je jedan od najpoznatijih alata za vođenje projekata. 
Terminološki gledano, JIRA projekat je skup zadataka, koji su de�nisni i 
oblikovani u cjeline, po zahtjevu projekta ili u odnosu na način na koji 
�rma radi. Na primer, JIRA projekat može biti:

• projekat razvoja softvera;
• marketinška kampanja;
• sistem upravljanja zahtjevima za odsustvo sa posla;
• unapređenje ili održavanje web stranice, itd.

preko web-sajta stiže i na e-mail 
vlasnika sajta.   

Druga Wix opcija je Wix ADI, koji 
korisnika inteligentno vodi kroz 
pojedinačna pitanja i omogućava 
da se uzimajući u obzir odgovore, 
kreira web-sajt po želji. Potrebno 
je da navedite osnovne informaci-
je kao što su tip �rme, kontakt 
podaci i prisustvo na mrežama, a 
Wix ADI će uraditi sve ostalo. I dalje 
ćete moći da uređujete stil i izgled 
svoje web lokacije, ali umjesto 
povlačenja i ispuštanja, Wix ADI 

radi u odjeljcima kojima se može 
pojedinačno pristupiti i koji se 
mogu promijeniti. Wix ADI je nami-
jenjen manje tehnički orjentisanim 
korisnicima i onima koji nemaju 
puno vremena da istražuju sve 
opcije Wix Editora. 

Pogodno je što u svakom trenut-
ku, dok korisnik radi u Wix ADI 
režimu, može klikom na Go to 
Editor preći u režim Wix Editora, 
odnosno dok radi u editoru, klikom 
na Site -> Go back to ADI, opet se 
vratiti u režim ADI-a.

ATLASSIAN JIRA
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Kreiranje zadataka:

Kada je jednom kreiran projekat, 
da biste kreirali JIRA zadatak u 
okviru njega, potrebna je dozvola 
za kreiranje zadataka od strane 
administratora JIRA-e. Ako to 
imate, treba kliknuti na Create na 
vrhu ekrana da biste otvorili 
dijalog Create Issue.

Ovdje je potrebno odabrati tip 
zadatka, de�nisati naslov i opis 
zadatka, dodijeliti ga nekome iz 
tima, te kliknuti na Create. Ovaj 
prozor sadrži još nekoliko dodat-

Quickbooks je softver za evidenci-
ju i vođenje �nansija u �rmi koji je 
razvio i plasirao Intuit. Uglavnom 
se koristi u malim i srednjim predu-
zećima i nudi module za automa-
tizaciju plaćanja, kreiranje i distri-
buciju računa, obračun zarada i sl. 

Prvi korak prilikom korišćenja ovog 
alata treba da bude podešavanje 
detalja o kompaniji. Za to se koristi 
opcija Settings u gornjem desnom 
uglu kontrolne table. Ovdje je na 
raspolaganju nekoliko grupa 
podešavanja, a glavna se odnose 
na detalje o kompaniji, detalje o 

nih opcija koje možete a i ne 
morate popuniti, poput da li je 
zadatak vidljiv samo za neke ili za 
sve uloge u JIRA-i, možete zakačiti 
prilog, ali i de�nisati da li napredak 
na tom zadatku možda zavisi od 
nekog drugog zadatka. Nakon što 
je jednom kreiran, zadatak će se 
pojaviti u prvom statusu radnog 
toka (najčešće To Do), zavisno od 
templejta koji je izabran. Promjena 
statusa svakog zadatka se vrši 
pomjeranjem konkretnog zadatka 
u sledeće statuse (i za ovo se mora 
imati dozvola administratora) 
izabranog radnog toka (najčešće 

In Progress ->In Review ->Done 
->Veri�ed, mada može da bude i 
drugačije, zavisno od podešavanja 
radnog toka).

Dodavanje osoba koje će činiti tim 
na projektu se radi klikom na 
People u navigaciji, zatim Add 
People to Jira. Nakon ovoga, otvara 
se poseban prozor u koji je potreb-
no unijeti e-mail adrese svih koje 
želite da pozovete za učešće na 
projektu. Nakon njihove veri�kaci-
je, svim članovima tima je moguće 
dodijeliti svaki novokreirani
zadatak.

QUICKBOOKS

korisnicima koji koriste softver, 
zatim podešavanja izgleda izlaznih 
faktura, poreskih stopa i de�n-
isanje kontnog plana.

U glavnom meniju sa lijeve strane, 
na raspolaganju su stavke 
povezivanja sa bankom (podržane 
su inostrane banke), u kojem 
slučaju bi transakcije automatski 
pristizale u softver, ali i dvije 
glavne stavke - trošenja i prihodi 
od prodaje. Ovdje korisnik može da 
kreira izlaznu ili ulaznu fakturu, 
nakon što je ranije de�nisao 
kontni plan. Klikom na Sales ->All 

Sales ->Create an Invoice otvara 
se poseban prozor za kreiranje 
izlazne fakture. U tom procesu 
potrebno je izabrati kupca/klijen-
ta, unijeti e-mail na koji će biti 
proslijeđena kopija fakture, 
takođe �zičku adresu za slanje, 
broj fakture, datum fakture, 
valutu plaćanja, dok se rok za 
plaćanje izračunava automatski. 
Nakon toga slijedi unos svih stavki 
fakture sa de�nisanjem opisa, 
količina i cijena. Skoro identična 
procedura, samo da manje detalja, 
je potrebna za unos ulazne 
fakture (Expenses -> Add 
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Expense Manually). U okviru 
menija, kroz stavku Employees se 
unose zaposleni (Employees 
->Add new employee), gdje je 
potrebno popuniti detalje poput 
imena, prezimena, adrese, e-mail 
adrese, datuma rođenja, te drugih 
detalja o zaposlenju. Nakon ovoga, 
u softveru je moguća evidencija 
zarada.

Konačno, kroz stavku Reports, na 
raspolaganju su razni tipski 
izvještaji, kao i kratki pregledi na 
uvodnoj kontrolnoj tabli. Softver 
se nudi u 3 komercijalna paketa, 
između 14$ i 29$ mjesečno.

Udemi.com je američki provajder 
masovno dostupnog znanja kroz 
kurseve, namijenjen odraslima i 
studentima. Osnovali su ga u maju 
2010. godine Eren Bali, Gagan 
Biiani i Oktai Caglar.

Od januara 2020. godine, platfor-
ma ima više od 35 miliona onih koji 
uče i 57.000 instruktora koji drže 
kurseve na preko 65 jezika. 
Studenti i instruktori dolaze iz više 
od 180 zemalja, a 2/3 učenika se 
nalazi van Sjedinjenih Država. 
Studenti pohađaju ove kurseve sa 
ciljem usavršavanja vještina veza-
nih za posao. Sjedište Udemi-a 
nalazi se u San Francisku, a 
kancelarije na još 5 lokacija širom 
svijeta.  

UDEMY.COM

Kursevi se nude u različitim kate-
gorijama, uključujući biznis i 
preduzetništvo, umjetnost, zdrav-
lje i �tnes, jezik, muziku i 
tehnologiju. Udemi takođe nudi 
opciju "Udemi za kompanije", omo-
gućavajući kompanijama pristup 
ciljanom paketu od preko 7.000 
kurseva o temama koje pokrivaju 
ključne oblasti za biznis - od 
taktike digitalnog marketinga do 
produktivnosti zaposlenih, dizaj-
na, upravljanja, programiranja i još 
mnogo toga. Kursevi na Udemi-ju 
mogu biti plaćeni ili besplatni, u 
zavisnosti od instruktora.
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TED.COM

TED je nepro�tna organizacija 
posvećena širenju ideja u obliku 
kratkih, inspirišućih videoa koji 
traju 18 minuta ili manje. Nastao je 
1984. godine kao konferencija na 
kojoj su se tehnologija, zabava i 
dizajn spojili, a danas pokriva 
gotovo sve teme - od nauke, preko 
biznisa do globalnih pitanja - na 
više od 100 jezika. U međuvre-
menu, samostalno vođeni TEDx 
događaji pomažu u razmjeni ideja 
u državama širom sveta. TED.com 
je svojevrsna baza besplatnog 
znanja od najnadahnutijih svet-
skih govornika iz različitih oblasti. 
Platforma je u vlasništvu nepro-
�tne, nestranačke fondacije, sa 
idejom da utiču, inspirišu i učine 
neke dobre ideje dostupnim.

1PASSWORD

1Password je softversko rješenje 
za čuvanje lozinki koji je razvio 
AgileBits Inc. Omogućava korisni-
cima da čuvaju razne lozinke, 
ID-eve, informacije o kreditnim 
karticama, softverske licence i 
druge osjetljive informacije u 
virtuelnom sefu, koji je zaključan 
master passwordom koji je 
zaštićen PBKDF2. Ova password 
se ne čuva na istoj lokaciji na kojoj 
su korisničke lozinke 1Passworda. 
Takođe, otključavanje 1Pass-
worda može da se, umjesto 
pomoću master passworda, uradi 
otiskom prsta na MacBook Pro, 
iPhone, iPad i Android uređajima. 
1Password ima dodatak za web 
pretraživače Safari, Chrome, 
Firefok, Edge i Opera, koji omogu-

ćava da pamti sva logovanja na 
web lokacije koje korisnik posjeću-
je, automatski popunjava polja za 
prijavu i generiše nasumične 
lozinke za nove web lokacije.

1Password je dostupan i u varijanti 
za mobilne telefone, i to za iOS i 
Android, počevši od iOS 12, odnos-
no od Android Oreo i noviji.

Kreiranje nove stavke u 1Pass-
wordu vrši se na sledeći način:

Kada otvorite 1Password, vidje-
ćete listu svih svojih stavki, poput 
lozinki ili kreditnih kartica.

Ako je 1Password potpuno prazan, 
nove stavke se kreiraju na sledeći 
način: kliknite dugme + u vrhu 
ekrana ili odaberite File ->New 
Item, pa vrstu lozinke koju želite 
da sačuvate. Unesite detalje i 
kliknite na Save. Da biste izmijenili 

neku od postojećih lozinku, potre-
bno je da je izaberete i kliknite Edit 
u vrhu ekrana ili Item ->Edit. Kada 
završite sa izmjenama, kliknite na 
Save.

Svaku od stavki je moguće brzo 
pronaći unošenjem imena stavke 
u polje za pretragu na vrhu ekrana. 
Takođe, ukoliko korisnik ima 
mnogo lozinki koje čuva, može da 
napravi uži izbor stavljanjem 
izabranih stavki u Favorites opciju, 
u lijevom meniju.

Cijena 1Passworda zavisno od 
režima (individualno korišćenje ili 
za kompanije) i paketa počinje od 
2.99$ mjesečno, a može biti i do 
7.99$.



Fiverr je izraelska platforma za 
osobe koje nude svoje usluge u 
različitim oblastima poput dizajna, 
programiranja, prevodilačkih 
usluga, video montaže itd, i 
kompanije kojima jednokratno 
trebaju takve usluge.  Fiverr je 
pokrenut u februaru 2010. godine, 
a već do 2012. je nudio više od 1.3 
miliona usluga. Tokom 2013. i 
2014. pokrenute su i iOS odnosno 
Android aplikacije sa istom 
svrhom.

Sve usluge na Fiverr-u se nazivaju 
"Gig". Ponuđači imaju mogućnost 
da odaberu početnu cijenu svoje 
usluge, a mogu i da ponude više 

Da biste zatvorili svoj Fiverr nalog, 
potrebno je uraditi sledeće:
1) Kliknite na svoju pro�lsku sliku
2) Izaberite My Settings
3) Pomjerite mišem naniže i 
pronađite opciju Account
Deactivation

FIVERR

varijanti cijena koristeći tkz. Gig 
pakete, gdje se u okviru paketa 
de�niše opseg usluga koje neko 
nudi.  

Prijavljivanje za Fiverr je besplat-
no, ali obavezno, jer samo regis-
trovani korisnici mogu da kupuju i 
prodaju na Fiverr-u. Registracijom 
jednog naloga najprije postajete 
kupac usluga, a naknadno je taj 
nalog moguće transformisati u 
nalog ponuđača usluga. Procedura 
registracije izgleda ovako:
1) Na početnoj stranici Fiverr-a 
potrebno je kliknuti link Join;
2) Zatim unesite svoju e-mail 

adresu i kliknite Continue. Osim 
e-mail adresom, možete se 
pridružiti i preko Facebook-a, 
Google Connect-a i Apple 
Connect-a;
3) Odaberite korisničko ime, 
vodeči računa da se ono ne može 
promijeniti nakon što kreirate 
nalog, i da će to biti vaše ime za 
prikaz pro�la, kao i usluga koje 
nudite ili kupujete;
4) Izaberite lozinku i kliknite Join;
5) Ako je sve urađeno kako treba, 
dobićete aktivacioni e-mail na 
adresu koju ste unijeli u koraku 2, 
koji sadrži link Activate Your 
Account koji treba kliknuti;

Da biste postali ponuđač usluga na Fiverr-u, kada 
kreirate svoj nalog prateći gornja uputstva, treba da 
kliknete na svoju pro�lsku sliku i izaberete „My 
Settings“. Zatim kliknite na „Dashboard“, a zatim na 
„Start Selling“. Na novoj stranici koja se otvorila, 
potrebno je da ponovo kliknete Start Selling da biste 
postali ponuđač usluga. Ovo će započeti proceduru 
u okviru koje možete vidjeti tri video zapisa sa 
korisnim informacijama o tome kako koristiti Fiverr 
kao ponuđač. Kada završite sa pregledom video 
snimaka, trebalo bi da napravite javni pro�l prodav-
ca. Polja sa zvjezdicom su obavezna i imajte na umu 
da što tačnije i detaljnije napišete informacije, to će 
vaš pro�l ponuđača biti bolji i uspješniji.

Na kraju ovog procesa tražiće se da telefonom 
veri�kujete svoj nalog, a zatim ćete biti zamoljeni da 
kreirate svoj prvi Gig koji će predstavljati ponudu 
vaše usluge na Fiverr-u.

Zatvaranje Fiverr naloga

Izaberite razlog za deaktivaciju 
naloga iz padajućeg menija i 
kliknite na „Deactivate Account“.
Napomene:
• Ne možete da zatvorite nalog 
kada imate raspoloživa sredstva 
na računu. Cijeli iznos mora biti 

vraćen ili podignut prije nego što 
se nalog zatvori.
• Korisnička imena koja ste 
jednom koristili, pa deaktivirali, a 
isto važi i za e-mail adrese se ne 
mogu ponovo koristiti na novom 
nalogu. 
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JIRA SERVICE DESK

Jira Service Desk je program za 
rješavanje zahtjeva klijenata, bilo 
da ih šalju e-mailom, putem help/-
support portala ili putem specijal-
nih vidžeta. Jira Service Desk je 
napravljen na platformi Atlassian 
Jira, pa ćete u njemu sigurno vidjeti 
neke pojmove i koncepte koji su 
zajednički za sve Atlassian-ove Jira 
proizvode. 

Svi zahtjevi su podijeljeni u 
različite oblasti, na primjer IT, HR, 
�nansije i sl. a na oblastima može 
da radi jedan ili više agenata koji 
prijavljuje i prati progres različitih 
zahtjeva. Prednost Jira Service 
Desk-a u odnosu na druge 
softvere za komunikaciju sa kljen-
tima je to što ga je moguće integri-
sati sa drugim Atlassian proiz-
vodom koji se zove Con�uence, na 
kojem se može kreirati i postavili 
baza znanja. 

Kako se postaje agent?

Da bi neko postao agent na posto-
jećem Jira Service Desk projektu, 
potrebno je da mu administrator 
projekta uputi poziv. Da biste 
prihvatili pozivnicu, treba uraditi 
sledeće:

• Pronađite e-mail sa pozivnicom 
koja sadrži ime administratora koji 
vas je pozvao
• Kliknite Join them now i podesite 
svoj Atlassian nalog.

• Zatvaranjem naloga ne uklanjaju 
se podaci na njemu. Ostaće 
komentari, poruke i javne slike. Da 
biste ovo uklonili, morate trajno 
obrisati nalog.

Za trajno brisanje naloga, potreb-
no je poslati zahtjev Support timu 
Fiverra, ali tome treba da prethodi 
deaktivacija naloga po prethodno 
opisanoj proceduri. Ovaj postupak 
je trajan i ne može se poništiti. 

Stoga se preporučuje da pregle-
date svoje porudžbine i poruke pri-
je nego što zatražite trajno brisan-
je, kako biste mogli da preuzmete 
sve informacije koje će vam možda 
zatrebati u budućnosti.

Nakon što ste kreirali nalog, ako 
imate samo jedan projekat na Jira 
Service Desk-u, logovanje će vas 
odvesti direktno u njega. Međutim, 
ako ste dodati u više projekata ili 
imate pristup drugim Atlassian 
aplikacijama, u glavnom horizon-
talnom meniju na vrhu treba 
kriknuti Projects, pa izabrati konk-
retan projekat Jira Service Deska. 

Iako vaši klijenti mogu i sami 
prijaviti problem, ponekad ćete 
možda biti u prilici da podnesete 
zahtjev umjesto nekoga od njih. 
Postoje 2 načina na koji adminis-
tratori i agenti mogu da podnesu 
zahtjev u ime klijenta:

• Na vertikalnom meniju lijevo 
kliknite na Create
• Pronađite templejt zahtjeva koji 
odgovara vrsti problema vašeg 
klijenta. U polju Raise this request 

pronađite klijenta u padajućem 
meniju ili unesite njegov e-mail
• Popunite detalje zahtjeva i 
kliknite na Create
• Odaberite vrstu zahtjeva i 
Vašem klijentu će na e-mail slići 
link do kreiranog zahtjeva

Alternativno, ako ste već u projek-
tu Jira Service Desk, kliknite na 
Raise a request. Ostali koraci su 
identični.

Ako je zahtjev klijenta riješen, 
administratori i agenti mogu da ga 
zatvore slijedeći naredne korake: 

• Iz projekta izaberite opciju 
Queues;
• Izaberite zahtjev koji želite da 
zatvorite;
• Izaberite Status i pređite na Set 
as Done.


